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Chapter 2 -  Safety information
• Read this manual carefully before using the module 13/013.

• Keep the manual carefully and in a place of easy access in order to consult it later in case of need.

• Make sure this manual is delivered to the end user.

The safety symbols used in this manual are described below:

DANGER: 

This symbol indicates the possibility of even serious injuries to people, due to electrical or mechanical shocks. 

ATTENTION:

This symbol indicates the possibility of damage to things or to the module itself.

WARNINGS:

Additional information useful for proper use of the module.

✔ Make sure that the power supply voltage of the module matches the plate data.

✔ Never feed the module without the lid and never remove the lid while the power supply is present. 

✔ Do not perform manipulations on the module with wet hands. There is a danger of electrical shocks. 

✔ Before starting wiring make sure there is no power supply. 

✔ All power sources must be disconnected before any maintenance is carried out. 

✔ Maintenance, inspection and replacement shall be carried out by a designated person.

✔ Always fix the module before wiring. 

✔ The installation must be carried out by qualified technical personnel. 

✔ To comply with the regulations on electrical safety, make the mass connections according to the standards 
of the country where the module is installed. 

✔ Install a protective circuit (fuse or magnetic switch) on the module power supply. 

✔ Never change the module. 

✔ Clean the module with a vacuum cleaner. Do not use organic solvents. There is a danger of damaging the 
module. 

✔ It is essential for your safety that any revision of the module is carried out by our company. 

✔ In the case of disposal, the module must be considered an industrial waste, therefore comply with the rules 
imposed by the laws in force in the country in which it is installed. 

The module 13/013 complies with the following industrial standards:

Standard/Marking Description

CEI EN 60204-1 Low voltage safety directive, 73/23/EEC. 

CEI EN 61800-3 Product standard related to EMC Directive 89/336/EEC. 

CEI EN 60529 Degree of protection IP20. 

EC CE marking. 
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Chapter 3 -  Technical characteristics
3.1 Generality
The module’s function 13/013 is to convert the signal of a serial encoder into an incremental TTL Line Driver encoder with Hall sec -
tors.

Supported serial encoders;

• Fanuc:

◦ Αi64 (Type: A860-0365).

◦ ΑiAR128 ( Type: A860-2010-T341).

◦ ΑiA1000 (Type: A860-2000).

◦ Α64iA (Type: A860-2014-T301).

◦ ΑA64 (Type: A860-0360-V501 and Type: A860-0360-T001).

◦ ΑiA16000 (Type: A860-2001-T301).

◦ ΒiA128 (Type: A860-2020-T301).

• Mitsubishi.

The module signals the alarms in the encoder and self-configures with the parameters of it.

In addition, the module provides a digital +24V output to signal faults and block motor operation or other accessories.

All commands are opto-isolated and run at 24Vcc in positive logic and can be generated by: buttons, relay contacts, PLC outputs, etc.
and come from one or more points. 

The digital outputs are opto-isolated, run at 24Vcc in positive logic and are electronically protected against overload and short circuit.
The status of commands and outputs is displayed with Led.

All settings are made with a PC connected to the module’s USB port using the software provided by ALTER, and are stored inside the
module.

The electronic circuits and I/O connectors are on a printed circuit board placed inside a metal case to have the best shielding against
disturbances.

The alarms are stored in the module, can be displayed via the PC and reset via a special digital input.
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3.2 Identification plate
Explanation of the various fields of the plate:

1. Manufacturer’s name, address, contacts.
2. Supply voltage auxiliary services.
3. Version of Firmware loaded into the module.
4. Serial number of the module.
5. Type of module.
6. Model of the module.

All other spaces not indicated, are not used in this product.
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3.3 Technical data
• Execution for fixing on panel. Degree of protection IP20.
• Ambient operating temperature: from 0 °C to +40 °C.
• Storage temperature: from -10 °C to +70 °C
• Relative humidity max.: 95 % without condensation.
• Maximum altitude: 1000 m. a.s.l.
• Single-phase service supply: 85÷264Vca (47÷63Hz), 120÷370Vcc – 500mA max (protection with delayed fuses 250V – 1A).
• Over-voltage protection on:

◦ Signal inputs and outputs.
◦ Service supplies.

• Service connections and signals on removable connectors
• Opto-isolated logical inputs (command from 15 to 30Vcc – 10mA max).
• Opto-isolated logic outputs (24Vc. – 100mA max) protected against overload and short circuit.
• Analog outputs in voltage, with resolution 14 bit + sign (±10V max. – output resistance 100 Ω).
• Power outputs for references:

◦ +24V ±1 % – 100mA max.
◦ +10V ±5 % – 5mA max.
◦ -10V ±5 % – 5mA max.

• LED display of digital I/O logical states, present alarms, working module.
• Diagnostics and programming with software on PC (Windows), with the ability to copy configurations from PC to module

and vice versa.
• Signaling anomalies and alarms on a digital output.

3.4 Functional scheme
In the following figure you can see a functional diagram of the module that represents all the inputs, the outputs available, with the
relative commands and signals, as in the factory standard configuration.

Some inputs and outputs can be modified by the customer according to their needs.
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Chapter 4 -  Installation
4.1 Preliminary operations

• Check that the module has suffered no damage in the transport.

• Mount the module vertically away from heat sources.

• Use unpainted sheet fixing panels connected to the ground.

• Connect to a good ground one of the ground terminals placed on the sides of the module.

• Follow the link patterns shown in the manual.

• Use shielded cables for signal connections.

• Connect to the ground on the carpentry or on the terminals arranged on the two ends of the shields.

• Do not use terminal blocks but only shielded connectors for signal shielded cable junctions.

• Mounting noise suppressors (off for c.a./diodes per d.c.) parallel to the coils of all contactors, relays, solenoid valves, single-
phase motors, three-phase motors, etc.

4.2 Connection power supply services (X1)
The service supply is connected to the removable connector identified with the ACL and ACN inscriptions at
the top of the module; this supply voltage can be supplied by an alternating current or direct current network
without any particular setting.

In the case of AC power supply, the voltage shall be between 85 and 264Vac (frequency from 47 to 63 Hz); in-
stead, in the case of continuous power supply the voltage must be between 120 and 370Vdc.

In both cases it is mandatory to protect the module with a pair of fuses adapted to the voltage used, with a cur-
rent size of 1A delayed. 

4.3 Signal connections
With reference to drawing 16 on page 24, starting from the upper side of the module we find the signal connectors that are described
in the following paragraphs.

4.3.1 Analog input connector (X2)
NAME DESCRIPTION

+10V Output +10Vcc ±5 % – 5mA max.

-10V Output -10Vcc ±5 % – 5mA max.

A0V 0V analog. The analog 0V is connected to the module case.

AI1+ Hot pole of the analog input 1.
Not used.

I1- Cold pole of the analog input 1.

AI2+ Hot pole of the analog input 2.
Not used.

I2- Cold pole of the analog input 2.

AI3+ Hot pole of the analog input 3.
Not used.

I3- Cold pole of the analog input 3.

A0V 0V analog. The analog 0V is connected to the module case.

Features common to all analog inputs:

• Maximum voltage: ±10V between pole + and pole – or with respect to A0V.

• Input resistance: 110KΩ.

• Resolution: 11 bit + sign or 15 bit + sign.

Always use good quality shielded cables and connect the two ends of the shield to the ground. On the module case, near the connect-
ors, anchorages are available for the shields.

4.3.2 Connector analog outputs (X3)
NAME DESCRIPTION

AO1 Analog output 1. Angular position encoder.

A0V 0V analog. The analog 0V is connected to the module case.
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NAME DESCRIPTION

AO2 Analog output 2. Not in use.

A0V 0V analog. The analog 0V is connected to the module case.

AO3 Analog output 3. Not in use.

A0V 0V analog. The analog 0V is connected to the module case.

Features common to all analog outputs:

• Maximum voltage: ±10V (or 0 ÷ 10V) between the output pole and A0V. 

• Output resistance: IT’S 100 Ω.

• Resolution: 14 bits plus sign.

Always use good quality shielded cables and connect the two ends of the shield to the ground. On the module case, near the connect-
ors, anchorages are available for the shields.

NOTE: Due to the output resistance of 100 Ω, it should be considered that it may be necessary to adjust the gain of the analog
output to reach the value of 10V indicated in the characteristics. For example: if the analog output is connected to an analog input
of a drive having an input resistance of 10KΩ, it must be considered that from vacuum to load the signal will fall by about 1 %, so
instead of 10V we will have 9.9V.

4.3.3 Can Bus connector (X4)
NAME DESCRIPTION

TRM Insertion of the bus termination resistance.

H Can bus wire H.

L Can bus wire L.

A0V 0V analog. The analog 0V is connected to the module case.

NOTE: in this module the “Can Bus” connector is not used.

4.3.4 USB connector (X5)
This connector is used to connect a USB cable type B to the PC for programming, diagnostics, saving parameters. For more informa-
tion see the section 5.2 on page 13.

4.3.5 Serial encoder input connector (X6)
This connector is used to connect the encoder to the module: It is mandatory to use a shielded cable with the conductors   twisted   in  
pairs to have a cleaner and more immune signal to possible disturbances and the shield must be grounded from both ends.

4.3.5.1 Fanuc Pulsecoder serial encoder 
To the module 13/013 you can connect a Fanuc serial encoder of your choice between the models indicated in paragraph ”  Generality  “  
on page   4  . To use other models, please contact our technical office.

The encoder shall be connected to the X6 connector according to the following table: 

ENCODER SIGNAL INPUT (X6)
CONNECTION

ENCODER

SIGNAL N. PIN SIGNAL

+5V (positive feeding encoder) 1 +5V

0V (Power supply 0V encoder) 2 0V

Pair shield REQ 8

Req+ serial interface 9 REQ

REQ- serial interface 10 *REQ

SD pair shield 16

SD+ serial interface 17 SD

SD- serial interface 18 *SD

0V (cable shield) – Connector box

View of the c  onnector type “D” 25 poles female   on the welding side.

There are various types of connectors on the Encoder side, below some known models:
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4.3.5.2 Mitsubishi serial encoder
To the module 13/013 you can connect a Mitsubishi   serial   encoder   to choose from among the models indicated in paragraph ”  General  -  
ity  “ on page   4  . To use other models, please contact our technical office.

The encoder shall be connected to the X6 connector according to the following table: 

ENCODER SIGNAL INPUT
(X6) CONNECTION

ENCODER MITSUBISHI

SIGNAL N. PIN PIN SIGNAL CONNECTOR

+5V (Power +) 1 S +5V

0V (Power supply 0V) 2 R 0V

SD (RX serial data) 3 H SD

SD (RX serial data) 4 J SD

SDpair shield 5

RQ (TX serial data) 6 K RQ

RQ (RX serial data) 7 L RQ

RQpair shield 8

0V (cable shield) – Connector box

View of the Flying connector type “D” 25 poles female on the welding side.
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TYPE 1

SIGNAL N. PIN

+5V K

0V T

REQ F

*REQ G

SD A

*SD D

TYPE 2

SIGNAL N. PIN

+5V 8

0V 7

REQ 6

*REQ 5

SD 2

*SD 1

TYPE 3

SIGNAL N. PIN

+5V 13+14

0V 3+4

REQ 7

*REQ 9

SD 8

*SD 10

TYPE 4

SIGNAL N. PIN

+5V 8+15

0V 2+10

REQ 5

*REQ 6

SD 12

*SD 13
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4.3.6 Emulated encoder output connector (X7)
EMULATED ENCODER OUTPUT (X7)

CONNECTION
CNC or DRIVE

SIGNAL N. PIN N. PIN SIGNAL

Channel “A” line-driver 5V 1

Channel ”A“ line-driver 5V 2

Channel “B” line-driver 5V 3

Channel ”B“ line-driver 5V 4

Channel “Z” line-driver 5V 5

Channel ”Z“ line-driver 5V 6

0V 9 -

HALL sector “SE1” line-driver 5V 10

HALL sector ”SE1“ line-driver 5V 11

HALL sector “SE2” line-driver 5V 12

HALL sector ”SE2“ line-driver 5V 13

HALL sector “SE3” line-driver 5V 14

HALL sector ”SE3“ line-driver 5V 15

0V (cable shield) – Connector box

View connector from the welding side (Connector type “D” 15 pole female).
This connector is used to send the signal of the emulated encoder to the CNC (or other users): it is identical to the signal provided by a
classic incremental TTL Line Driver square wave encoder with 4096 ppr (Pulse/turn) per channel.

If necessary, the setting of generated PPRs can be changed: See explanations for the configuration in the paragraph 5.6 on page 16.

Also on this connector it is advisable to use shielded cable with   twisted   conductors in pairs  .

4.3.7 Signal output connector Frequency/direction (X8)
NAME DESCRIPTION

F+ Frequency signal (Line Driver 5V – Direct Pole)

F- Frequency signal (Line Driver 5V – Reverse Pole)

D+ Direction signal (Line Driver 5V – Direct Pole)

D- Direction signal (Line Driver 5V – Reverse Pole)

There are two signals on this connector: frequency and direction. Generally these signals are used in step-by-step motor drives and
can also be called “Step/Direction”. For each turn of the encoder, a number of pulses (setable) on the Frequency signal are generated.
The two signals have this meaning:

• Frequency: on these terminals there is a variable frequency signal with the speed of the resolver. You can set the number of
pulses/turns that will be generated from 3 to 65000, referring to a turn of the encoder. Maximum frequency 4000 KHz.

• Direction: on these terminals there is a signal indicating the direction of rotation of the encoder (therefore the speed sign):
D+ = 0V if the direction is positive, D+ = 5V if the direction is negative. Obviously the logical state of D- is the inverse of
D+.

If the counting direction is opposite to the desired direction, you can reverse it by exchanging the wires connected to D+ and D-.

4.3.8 Digital input connector (X9)
NAME DESCRIPTION

DI1 Digital input 1: reset alarms

DI2 Digital input 2: command INCREASES electrical angle offset

DI3 Digital input 3: command DECREASES electrical angle offset

DI4 Digital input 4: unused

DI5 Digital input 5: unused

DI6 Digital input 6: unused

DI7 Digital input 7: unused

DI8 Digital input 8: unused
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NAME DESCRIPTION

DI9 Digital input 9: unused

D0V 0V digital inputs.

A0V 0V analog. The analog 0V is connected to the module case.

+24V Power supply +24V – 100mA max.

Power supply voltage from l8Vcc to 30Vcc (nominal 24Vcc). The 24Vcc power supply can be supplied by the module itself (if the
total current absorbed by the loads connected to the outputs does not exceed 100mA): Connect D24 with terminal +24V (see para-
graph 4.3.9) and D0V with A0V terminal. If the internal power supply cannot be used, an external power supply must be used.

The status of each digital input is displayed by the corresponding LED which indicates that the command is valid (see paragraph 6.1
on page 23).

Examples of connections to digital inputs:

4.3.9 Digital output connector (X10)
NAME DESCRIPTION

+24V Power supply +24V – 100mA max.

D24 Common to connect to +24Vcc for digital outputs.

DO1 Digital output 1: OK   module.  

DO2 Digital output 2: “  Communication Initialized  ” signal.  

DO3 Digital output 3: “  Position Initialized  ” signal.  

DO4 Digital output 4: “  Timeout   S  erial Communication Error  ” Signal.  

DO5 Digital output 5: “  serial data error”   signal.  

DO6 Digital output 6: “  E  ncoder   internal fault  ” signal.  

Power supply voltage from l8Vcc to 30Vcc (nominal 24Vc.c.). The 24Vcc power supply can be supplied by the module itself (if the
total current absorbed by the loads connected to the outputs  does not exceed 100mA): Connect D24 with terminal +24V and D0V
with A0V terminal (see paragraph 4.3.8). If the internal power supply cannot be used, an external power supply must be used.

States of outputs:

Off = Floating

On = Connected to +24V power supply (D24) (marked by the power on of the corresponding led)

Without service power all outputs are OFF.

Maximum current for each output 100 mA, voltage drop inside the maximum current 2V. In case of overload or short circuit on one or
more outputs all the outputs are forced into the OFF state permanently and the module signals the anomaly.

The state of each digital output is displayed by the corresponding LED indicating that the output is controlled (see paragraph 6.1 on
page23).

NOTE: The GREEN LEDs of this module that signal the status of the corresponding digital output from DO3 to DO5, are flashing
when the signal is active (so the digital output is 24V), because they are alarms or warnings of malfunctions.

Examples of connections to digital outputs:
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4.4 Restarting after an alarm
When the module enters alarm status (DO1 output = OFF and flashing of the red FLT LED) the truthfulness of the
output signals (Frequency/Direction, emulated encoder) is not guaranteed, so  the user must take steps to avoid
faults or dangers to things or people.

After detecting the cause of the alarm, the module may be reset by one of the modes indicated 5.14.1 in paragraph
on page 22.
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Chapter 5 -  Commissioning
To configure the module you need to be provided with:

1. A PC with Windows operating system.

2. A free USB port on your PC (you can also use a Hub Usb).

3. A USB connection cable type B (the one used for USB printers).

4. The software to be uploaded to the PC to interface to the module (supplied by Alter on request).

5. The driver for USB connection (if an Internet connection is available, this is not necessary as the module is Plug & Play and
the driver is automatically downloaded).

In the absence of one of the above points it will not be possible to configure or do a diagnostic of the module.

NOTE: this manual does not deal with the topic of installing the software, drivers or other problems related to compatibility with
the PC supplied to the customer. In case of need, you can contact the ALTER technical office. Putting into service presupposes that
the customer’s PC is configured and ready to use.

5.1 Predispositions
Before setting the parameters in the module it is mandatory to follow these points:

• Connect the cable between Encoder and X6 connector as indicated in paragraph 4.3.5 on page 8.

• Connect the cable between the drive (or other user of the emulated encoder) to the X7 connector as specified 4.3.6 in para-
graph on page 10.

• Supply the auxiliary power supply to the appropriate terminals (see paragraph 4.2 on page 7).

• All the LEDs will turn on for 3 seconds (Led Test), then most of them will turn off.

• Check that the green LED “ON” is flashing. For the moment the other LEDs don't matter.

• Connect a head of the USB cable to the module X5 connector and the other end to a free USB port in the PC.

• If necessary, wait for the PC to install the driver for the module.

• Launch the programming software on your PC.

5.2 Introduction to PC software
After starting the application on your PC, go to the top menu and click "File → Open Project", select the project ”13-013_V0400_EN-
.pmp. At this point you have 4 zones where you can see different data:

1. At the top we find the ”Toolbar“ with various buttons to perform some functions.

2. On the left side we find the ”Project Tree“ where you can select the various groups of parameters that have been assembled
for simplicity, the various oscilloscopes to analyse low rate signals or recorders to analyse fast signals.

3. At the bottom we find the ”Variable Watch“ where the variables will be displayed with their real-time updated value, the
parameters to be modified and any commands (reset alarms, save parameters, etc.).

4. In the central part we find an area that can change functioning according to the context. In this part we can find:

1. “Algorithm block description“ showing drawings or instructions to facilitate calibration or to clarify the meaning of
the variables listed in the "Variable Watch" part.

2. “Oscilloscope“ in which you see some variables (maximum 8) displayed in graphic form relative to a time base or com-
pared to another variable (Graph X-Y). The update of these variables is related to the bit-rate of communication between
PC and module, so changes in fast signals cannot be represented.

3. “Recorder“ in which you see some variables (maximum 8) displayed in graphic form relative to a time base or com-
pared to another variable (Graph X-Y). The update of these variables is related to the speed of the fastest cycle (which
can be seen in the menu "Diagnostics" parameter "Fast cycle: period"), so it is able to represent variables that change in
the order of microseconds.

Without going into the details of all the functions of the various menus and buttons, the following paragraphs will explain how to con-
figure the module using the software on the PC to allow a quick commissioning to the user.

5.3 Activation of the communication port
• In the top menu select “Project → Options”.

• From the window that appears, select the “Comm” tab and set the following values:

◦ RS232 Port: COM_ALL

◦ RS232 Speed: 57600.

• Press “OK” to save changes.

• Press the “SAVE” button in the “Toolbar” to update the project.

• Press the red button “STOP” in the “Toolbar” to make the blue outline disappear.

Alter Elettronica s.r.l. 13
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• If communication between the PC and the module is correct, the words ‘RS232’ should not appear on the PC and in the
lower right edge; COMx; Speed=57600”.

• At this point we can continue with the other paragraphs.

5.4 How to Change Values
Generally the parameters that can be changed are highlighted with a certain color.

To change the value, do this:

• With the Windows Pointer, click once on the value you want to edit.

• To the right of the value will appear a gray square with a low arrow: Click on it once (see drawing 6).

• At this point there are two situations:

1. The value to be modified is highlighted  : in this case you can write a numerical value with the numerical keyboard.

2. A window with written values   appears: in this case it is mandatory to choose from the listed values.

• At the end of the choice, press ENTER key.

• If the value remains written and if there is no alarm message at the bottom left, then the parameter has been accepted and is
already operational.

5.5 Rapid commissioning
First of all, check that the state of the front LEDs is as indicated in these points:

• The red led FLT is OFF.

• The green LED DO1 is fixed ON.

• The green LED DO2 is fixed ON.

• The green LED “ON” is FLASHING.

If you do not get this result you need to go to the paragraph 5.14 on page 21 to detect the cause of the problem.

At this point you can start putting into service that differs according to the type of user connected to the X7 connector. So from the
simplest to the most difficult we can distinguish 4 different procedures: 

1. Connection to an ALTER drive model PWM3D (go to page 14).

2. Connection to a CNC, PLC or other user that does NOT use Hall sectors (pins 10 to 15 of X7 are not used) (go to page 15).

3. Connection to a generic drive that does not include automatic phasing (e.g. ALTER BTD1 models) (go to page 15).

Follow the paragraph based on your configuration.

5.5.1 Connection to an ALTER drive model PWM3D
In this case the phasing procedure is fully automatic and is performed by the drive (see manual instruction of the PWM3D). The only
operations to be performed in the module 13/013 are the following:

1. In the “Project Tree” select the group “Module Parameter Setting”. At the bottom “Variable Watch” will appear some para-
meters that can be changed. Parameters to be inserted:

1.1. Select the serial encoder model connected to the X6 connector, with ”Parameters.EncoderType”.

1.2. Read the value of the parameter “Parameters.EmulEncType“ (generally 4096 PPR): this value shall be used during the
drive configuration and is the parameter of  “resolution encoder”; see drive manual.

2. For encoders type A860-0365 or A860-0360-T001 the setting of the motor poles is fixed at 8 poles (4 polar pairs). Instead on
the other models it is necessary to check the motor plate and possibly change the parameter ”Parameters.MotorPoleCoup“
that is in the  group “Encoder phasing” and enable the parameter ”Parameters.AutomPosIni”  to move the motor until it
reaches the position of zero.

3. In the “Project Tree” select the   group   “Save/Restore Parameters”  . In the first highlighted line of GREEN color click on the
letter on the right to store the changed parameters. For further information, see paragraph 5.13 on page 19.

4. Make a complete rotation of the motor by hand so that in the group "Encoder status“ the parameter “StsEncoder.PosIniOk"
becomes "INIT OK”.

5. Follow the installation explained in the instruction manual of the PWM3D drive, remembering that the parameters to be in-
serted in its display are:

5.1. Motor pole (Motor Pole): The number of motor poles as selected in the ”Parameters.MotorPoleCoup“ (see point 2).

5.2. Type of transducer (Feedback Type): TTL encoder.
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5.3. Encoder Resolution (Encoder Lines): 4096 or the value read in the parameter “Parameters.EmulEncType” some points
above.

The commissioning for this type of use ends here. If you want more information on the various menus available in the programming
SW, you can see from the paragraph 5.6 from 16 page onwards.

5.5.2 Connection to equipment that does not use Hall sectors
The only operations to be performed in the module 13/013 are the following:

1. In the “Project Tree” select the   group   “Module Parameter Setting”  . At the bottom “Variable Watch” will appear some para-
meters that can be changed. Parameters to be inserted:

1.1. Select the serial encoder model connected to the X6 connector, with ”Parameters.EncoderType”.

1.2. Set the parameter ”Parameters.EmulEncType“ (generally 4096 PPR) to the value required by the device connected to
X7.

2. In the group “Encoder phasing” disable the parameter ”Parameters.AutomPosIni“.

3. Put the equipment into operation and check that everything works properly. In the event that the direction of reading of the
encoder is opposite to that desired, it is necessary to change:

3.1. In  the “Project  Tree”  select  the group “encoder phase” and change the value of  the parameter  ”Parameters.Emu-
lEncDir“ from NORMAL to REVERSE.

4. Try the operation again.

5. In the “Project Tree” select the   group   “Save/Restore Parameters”  . In the first highlighted line of GREEN color click on the
letter on the right to store the changed parameters. For further information, see paragraph 5.13 on page 19.

The commissioning for this type of use ends here. If you want more information on the various menus available in the programming
SW, you can see from the paragraph 5.6 from 16 page onwards.

5.5.3 Connection to a generic drive
In this case the phasing of the transducer is done completely with the module 13/013. 

The operations to be carried out in the module 13/013 are as follows:

1. In the “Project Tree” select the group “Module Parameter Setting”. At the bottom “Variable Watch” will appear some para-
meters that can be changed. Parameters to be inserted:

1.1. Select the serial encoder model connected to the X6 connector, with ”Parameters.EncoderType”.

1.2. Read the value of the parameter “Parameters.EmulEncType“ (generally 4096 PPR): this value should be used during
the drive configuration and is the “encoder resolution”: see manual drive instructions.

2. For encoders type A860-0365 or A860-0360-T001 the setting of the motor poles is fixed at 8 poles (4 polar pairs). Instead on
the other   models   it is necessary to check the motor plate and possibly change the parameter ”Parameters.MotorPoleCoup“
that is  in the  group “Encoder phase” and  enable the parameter ”Parameters.AutomPosIni”  to move the motor until  it
reaches the position of zero.

3. In the “Project Tree” select the group “Save/Restore Parameters”. In the first highlighted line of GREEN color click on the
letter on the right to store the changed parameters. For further information, see paragraph 5.13 on page 19.

4. Connect two buttons to the DI2 and DI3 inputs of the module 13/013 (for convenience).

5. It is absolutely essential to avoid damage to the motor, connect the DO1 output of the module 13/013 to the drive so that
when it goes to logical level 0 the drive must disable and stop the motor. 

6. Disconnect the motor from the mechanics  , so that it can rotate freely without moving any part of the machine.

7. In the drive adjust the current limit to the minimum value.

8. In the drive set the “Number of motor poles” (if required) as selected in the ”Parameters.MotorPoleCoup“ (see paragraph
2), the transducer type (TTL encoder) and the resolution of the encoder as set in the module at the point 1 of this paragraph.

9. In the “Project Tree” select the group “encoder phase”:

9.1. Change the parameter ”CmdModule.PhaseReg“ to ACTIVE.

9.2. Change the parameter ”SpeedIncAngleOffs“ to 10.0°/sec. This way the offset variation will be fast.

9.3. Enable motor operation   with a very low speed reference (1 volts).

9.4. If the motor escapes and exceeds the speed set in the ”PhaseRegSpeed“ parameter (usually 500 RPM), the module is
alarmed: flashes red led FLT and the DO1 output goes to 0. The drive should have blocked the motor.

9.5. In this case it is necessary to reverse the direction of the encoder by changing the parameter “Parameters.EncoderDir"
from NORMAL to REVERSE.

9.6. Enable the drive again: the motor could lock or turn badly.

9.7. Control the input DI2 or DI3 to vary the parameter "Parameters.AngleEleOffs“ until you find the right one that makes
the motor run correctly.

9.8. If the above parameter has made a complete change of 360° and the right value is not found, you still need to change
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"Parameters.EncoderDir“, add 180° to the angle of “AngleEleOffs” and repeat from the previous point.

9.9. When you have found the right OFFSET value that allows a proper and controlled rotation of the motor, you can make a
finer adjustment with the next points.

9.10. Change the parameter ”SpeedIncAngleOffs“ to 1.0°/sec. In this way the offset change will be slower.

9.11. Enable motor operation   with a very low speed reference (approximately 10 RPM).

9.12. With the hand, the crank shaft of the motor must be braked lightly until the blows are heard on it due to the switching
of the windings.

9.13. Try to control the input DI2 (or DI3) until you feel that the shots are reduced. Instead if the blows increase you have to
act on the other digital input.

9.14. As an alternative to the use of DI2 and DI3 inputs, you can manually change the offset of the electrical angle by chan-
ging the parameter "Parameters.AngleEleOffs“ in small steps.

9.15. The points from 9.12 to 9.14 are to be repeated until satisfactory operation is achieved.

9.16. At the end, return the parameter "CmdModule.PhaseReg" in ”INACTIVE“ mode.

9.17. If the motor runs in the opposite direction, the parameter "Parameters.EmulEncDir“  from NORMAL to  REVERSE
must be changed.

10. At the end of this procedure, the modified parameters must be saved again: In the “Project Tree” select the group “Save/Re  -  
store Parameters”. In the first highlighted line of GREEN color click on the letter on the right to store the changed paramet -
ers. For further information, see paragraph 5.13 on page 19.

The commissioning for this type of use ends here. If you want more information on the various menus available in the programming
SW, you can see from the paragraph 5.6 from 16 page onwards.

5.6 Setting the module parameters
In the “Project Tree” select the group “Module Parameter Setting”. In the lower part “Variable Watch” will appear the parameters to
adapt the module to the equipment connected to the connector X7 and to the electric motor:

• EncoderType: select the serial encoder model connected to the module X6 connector.

• EmulEncType: select the type of encoder you want to emulate, among the following PPRs: 8, 16, 32, 64, 128, 256, 512,
1024, 2048, 4096, 8192. The greater the number of PPRs, the higher the frequency of signals A, B on the X7 connector.
From factory setting this parameter is 4096 PPR that offers an excellent ratio between precision and maximum frequency of
signals. The maximum frequency of signals on A and B of the X7 connector is calculated with:

F MAX =
PPR∗RPM MAX

60

FMAX: Maximum frequency (Hz) on conductors A, A, B, B.

PPR: Number of pulse/turns set in the parameter ”EmulEncType“.

RPMMAX: maximum speed of rotation of the encoder (RPM).

• StepDirPpr: [3 ÷ 65000]. Set the number of pulses for each turn encoder you want to get on the frequency output (X8 con-
nector). The greater the number of PPRs, the higher the signal frequency on the F+ and F- terminals.

NOTE: the parameter “StepDirPpr” must be set in conjunction with what is required by the connected tab downstream of the
module. The F+ and F- outputs guarantee operation up to 4000KHz, but both the connection cable and the receiving card must be
able to guarantee this frequency of signals. The frequency on F+ and F- terminals is as follows:

F MAX =
PPR∗RPM MAX

60

FMAX: maximum frequency (Hz) on F+ and F- terminals.

PPR: Number of pulse/turns set in the parameter ”StepDirPpr“.

RPMMAX: maximum speed of rotation of the encoder (RPM).

• MotAlarmEnable: enable alarm signal when the motor temperature probe intervenes.

5.7 Setting up digital inputs
In the “Project Tree” select the group “Digital Input Setting”: here you can change the settings of the digital inputs and check the cur-
rent logical state of each input. 
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Drawing 7: digital input stage

Setup.Invert: with this parameter you can reverse the lo-
gical state of the associated digital input, considering that 
if the input terminal is floating corresponds to a state 0 
(FALSE) instead if it is connected to +24Vcc the state is 1
(TRUE): this status is displayed with the related yellow 
LED on the front.

Value: this read-only parameter indicates the logical state 
available for blocks connected to that digital input.

Please note that digital inputs have a fixed function and cannot be modified by the customer. See paragraph 4.3.8 on page 10 to asso-
ciate the function with the digital input used.

NOTE: The yellow LEDs on the front signal the logical state of the digital input FIRST of the possible inversion of sign, then in-
dicate the logical state   of the input pin  . With reference to drawing 7, the LED displays the logical state of the point marked with
“Dix”.

5.8 Setting digital outputs
In the “Project Tree” select the group “Digital Output Setting”: here you can change the settings of the digital outputs and verify the
current logical state of each output. 

Drawing 8: digital output stage

Setup.Source: with this parameter you can view the 
source of the signal that will be used to control the digital 
output (you can NOT change the source).
Value: This read-only parameter indicates the logical state
of the source selected with ”Setup.Source“.
Setup.Invert: with this parameter you can reverse the lo-
gical state of the associated digital output (only those 
highlighted), considering that the state 0 (FALSE) main-
tains the floating digital output instead the state 1 (TRUE)
commands the output to +24Vcc.

Digital outputs already have established functions (see section 4.3.9 on page 11) and cannot be modified.

NOTE: The green LEDs on the front signal the logical state of the digital output AFTER the possible reversal of the sign, then in-
dicate the logical state of the output pin. With reference to drawing 8, the LED displays the logical state of the point indicated with
“Dox”.

5.8.1 Signal sources for digital outputs
As indicated in the previous paragraph, in this module it is NOT possible to change the source of the signal that will be sent to the di-
gital output by changing the parameter ”Setup.Source“. Below is a table showing the possible sources and the meaning of logical
states to understand the function of a certain output:

EXIT SOURCE DESCRIPTION State “FALSE” State “TRUE”

DO1 Module OK Whether there are alarms in the module. Alarms present Module OK

DO2 Com. Encoder INIT
The  serial  communication  with  the  encoder  has
been initialised. 

Not initialised Initialised

DO3 Pos. Encoder INIT
The encoder position has been initialised with the
passage in the ZERO position.

Not initialised Initialised

DO4 Timeout
Signal that serial communication between module
and encoder has exceeded the maximum time.

Communication OK Timeout

DO5 DataRX Fault Report error in the data received by the encoder Communication OK Data error rx

DO6 Enc. Intern. fault. Signal the presence of alarms inside the encoder. No alarms Alarm present

Table 1: Signal sources for digital outputs

5.9 Setting analog outputs
In the “Project Tree” select the group “Setting Analog Outputs”: here you can change the settings of the analog outputs and verify the
current output value. 

Alter Elettronica s.r.l. 17



Chapter 5 - Commissioning Module 13/013 Instruction manual 91/122 V4.0

Setup.Source: with this parameter you can select the source of the signal that will be sent to the analog output.
Value: This read-only parameter indicates the percentage value of the source selected with ”Setup.Source“.
Setup.Abs: this parameter is used to use the source value with or without the sign.
Setup.Gain: this parameter is a multiplication factor of the source value. The range ranges from -9,999 % to +9,999 %.
Setup.Offset: this parameter is a fixed value that is added to the signal before being sent to the output pin. The range ranges from -
100 % to +100 %.

Analog outputs already have established functions (see section 4.3.2 on page 7) that it is recommended to maintain. In any case, if ne-
cessary, it is possible to change or exchange the various signal sources between them.

5.10 Verification of encoder operation
In the “Project Tree” select the group ”  Encoder   status  “  : here you can check the operation of the serial encoder connected to the X6
connector:

• ComIniOk: indicate the serial communication with the encoder has been properly initialised. 

• PosIniOk: indicate the incremental position received by the encoder has been initialised with the passage in the ZERO posi-
tion.

• AngleMec: indicates current mechanical angle of the encoder in degrees.

• AngleEle: indicates current electrical angle of the encoder in degrees.

• SpeedRpm: indicates the current speed of the encoder in RPM.

• RevMec: indicates the number of mechanical revolutions carried out by the encoder.

• Flags: internal status of the encoder.

• PosMec: indicates the mechanical position considering both motor rpm and angular position.

In addition,  selecting the oscilloscope "Rx data    encoder    & speed“ or "Mechanical & electric    angle    (high speed)"  , you can read in
graphic form the angle, speed of the encoder and other useful data to perform a diagnostic on the operation. 

5.11 Frequency/direction output verification
In the “Project Tree” select the group “  Step/Dir Output  ”  : Here you can check the operation of the output frequency/direction (see
paragraph 4.3.7 on page 10) and change the PPR parameter. It is also possible to see on the oscilloscope the comparison between the
pulse/turn counter of this function compared to the mechanical position of the encoder.

The data available are as follows:

• Parameters.StepDirPpr: This parameter is the same as you can find in the module parameters setting menu (see paragraph
5.6 on page 16) and is used to set the number of pulses/turns that will be generated on the F+ and F- terminals.

• FioCounter: displays a pulse counter generated by the output Frequency/direction. The value will always be between 0 and
the number set in “Parameters.StepDirPpr” and is used to verify exactly how many pulses have been generated by the mod -
ule.

NOTE: it is not guaranteed that when the encoder is in position 0° the FioCounter counter is at 0 counting value: it is a simple
pulse counter.

5.12 Encoder phasing
In the “Project Tree” select the group “  encoder phas  ing  ”  : this menu is used to adjust the phasing of the encoder compared to the mo-
tor in which it is mounted. For use see paragraph 5.5.3 (at page 15).

In this menu we find the following parameters:

• CmdModule.PhaseReg: this parameter activates or disables the “Encoder phase Adjustment” mode, which means:

1. A maximum speed threshold is enabled which sends the module to “Fault” if it is exceeded. This is to protect the motor
in case of “escape” due to the inverted transducer.

2. With the inputs DI2 and DI3 you can increase or decrease the offset of the electrical angle and then the phasing. It is not
necessary to use digital inputs because you can also change the offset parameter with the SW of the PC; this possibility
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has been inserted to facilitate the operation.

• SpeedIncAngleOffs: [0,1 ÷ 25,5°/sec]. This parameter adjusts the increment speed (or decrease) in degrees/sec of the para-
meter “Parameters.AngleEleOffs” that will occur when you control the DI2 or DI3 inputs.

• Parameters.MotorPoleCoup: [1 ÷ 10]. This parameter sets the number of pole   pairs   of the motor.

• Parameters.AutomPosIni: by activating this parameter the angular and electrical position will perform “virtual” rotations
until the encoder can reach its zero position. The purpose of this function is to make the motor move even if the electrical
angle is not right: This happens because some types of serial encoders do not have the correct electrical position at power on.

• PhaseRegSpeed: [0  ÷ 30000 RPM]. Set the maximum speed threshold during phasing mode. If for any reason the motor
speed exceeds this threshold, the module goes to “Fault” signalling the “Over-speed” alarm.

• Parameters.AngleEleOffs: [-180° ÷ 180°]. Set a value of Offset that will be added to the true electric angle of the motor to
create an offset and compensate the position of the encoder with respect to the motor rotor. This parameter is automatically
changed with DI2 and DI3 inputs.

• Parameters.EncoderDir: this parameter is used to reverse the direction of the encoder and thus the sequence of the Hall
sectors with respect to motor rotation.

• Parameters.EmulEncDir: this parameter is used to reverse the direction of the output “Emulated encoder” in case the motor
does not rotate in the required direction.

• StsEndat.SpeedRpm: this read-only parameter indicates the current speed of the encoder in RPM.

• StsModule.AngleEle: this read-only parameter indicates the current electrical angle of the motor in degrees.

By selecting one of the oscilloscopes indicated with “Hall    sectors  ”   you can see the logical states of the outputs combined with the
Hall sectors (SE1, SE2, SE3) in comparison with the mechanical and electrical angles of the motor.

Please note that: AngleElectric=AngleMeccanic×PolePair and that PolePair = Parameters.MotorPoleCoup.

5.13 Save/Restore Parameters
All changes made to the parameters shall remain valid  until the
supply to the auxiliary services is lacking; if these changes have
not been saved (stored) they will be lost and on the next restart
the old data will be found. This feature has the merit that, in case
of accidental modification of one or more parameters, it is suffi-
cient to remove the power for a few seconds and then restore it to
return to the situation of the last save.

In this paragraph we will see how to memorise the parameters in
order to find them at the next start. Drawing 10: Save/Restore Parameters

In the “Project Tree”  select the group “Save/Restore parameters”: In the “Variable Watch” zone the parameters will appear as in
drawing 10.

Save parameters: in the 1st row we find the button to start the
“backup” procedure, follow these points:

• With the mouse pointer press once on the words “press
to start”.

• A gray square will appear (see picture on the side). Press
with the mouse pointer on the square.

• The word “START” will appear. Press the mouse pointer on the lettering.

• After a few moments in the 2nd line the words “BACKUP OK” (see drawing 11) will appear if the copy is finished cor-
rectly; otherwise “BACKUP ERROR” will appear and there will be error codes in the next rows. If necessary, these codes
can be communicated to ALTER to verify the malfunction.

• If the copy is finished correctly, you can also turn off the module without risk of losing the input values.

Restore parameters: In case of need it is possible to restore the 
factory parameters. Of course, all changes made during commis-
sioning will be lost. In order to avoid accidental restoration, the 
procedure to be carried out is more complex:
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• With the mouse pointer press once on the inscription “INACTIVE” on the orange color row with the words “ Factory data
reset”.

• A gray square will appear. Press with the mouse pointer on the square.

• A menu with two entries will appear: INACTIVE and ACTIVE. Select the item “ACTIVE”.

• At this point you have to get a situation as in drawing 12.

• Remove the power supply of the services for a few seconds and then restore it.

• At the end of the restart will be loaded the original parameters, but to make them definitive you need to overwrite the previ -
ous ones, following the procedure “Save parameters” in this paragraph.

NOTE: By forcing the user to follow this parameter restoration procedure, it is ensured that even in case of unwanted command
the previous data is not lost. In fact, even if the user accidentally performed a restoration, there is still the possibility of recovering
the error made: simply do NOT save the restored parameters, turn off and switch on again the module to find the previous para-
meters again.

5.13.1 Transfer parameters from module to PC
You can transfer the parameters from the module to the PC and save them to the HD for storage or to restore them to the module in
case of replacement. With the following procedure will be transferred all the parameters currently used in the module (i.e. those dis-
played in the various menus) that could also be different from those saved in the internal memory:

1. In the programming software click on the top menu "Tools → S-Record Transfer...“. A window will appear divided into four
zones with set values or buttons to press.

2. Check that everything is set at the top as in the following figure (except “address used”):

3. Check that everything is set at the bottom as shown in the following figure:

4. Press the “Read Flash...” button at the bottom left. A window will open that displays the data download phase.

5. After a few moments another window will appear with the request to indicate where to save the file.

6. It is recommended to create a folder “ALTER” in “C:” and assign a name to the data set that can then be easily located. In
this example we will call it “Prova_001.srec”.

7. Press "Close & Save Settings" at the bottom right to close the window.

NOTE: the parameters downloaded and stored on the PC HD can only be used to be transferred into the same module type with
the procedure explained in the next paragraph. It is forbidden to edit the file or transfer the parameters of another product: the
module notices this error and blocks the transfer.

5.13.2 Transfer parameters from PC to module
The parameters that have been stored on the PC with the procedure of the previous paragraph, can be transferred to the module with
the following points:

1. In the programming software click on the top menu "Tools → S-Record Transfer...“. A window will appear divided into four
zones with set values or buttons to press.

2. Check that everything at the top is set as in drawing 13 and bottom as in drawing 14.

3. In the middle “Input file” press the right button “...” and select the file to be transferred to the module: for example, we trans-
fer the data set stored in the previous paragraph. A situation similar to that of the following figure should be achieved:
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4. Press the “Write Flash” button at the bottom center: a window will appear showing the progress of the data transfer phase.

5. If the transfer takes place without errors, you will see the words “Flash Write operation finished successfully” appear in the
line “Status:”.

6. Press "Close & Save Settings" at the bottom right to close the window.

7. The new parameters are available in the module and can be checked by selecting the various “Project Tree” menus. To make
them definitive you need to save them in the internal memory of the module following the procedure indicated in the para-
graph 5.13 on page 19, otherwise the last parameters that were stored internally will return to the next reboot of the module.

NOTE: the parameters downloaded and stored on the PC’s HD can only be used to be transferred into the same module type. It is
forbidden to edit the file or transfer the parameters of another product: the module notices this error and blocks the transfer.

5.14 Module alarms
In the “Project Tree” select the group “  M  odule   alarms  ”  : here you can see the states of all possible alarms in the module.

When the red “FLT” LED flashes or the “OK module” output goes to level 0, it means that there is an alarm present. To understand
the cause you have to go to this menu is to check which of these alarms has the inscription “ALARM”.

List of alarms and possible resolution:

ALARM CAUSE RESOLUTION

StsEncoder.TimeOutFlt Exceeding  the  maximum  response
time by the serial encoder

Check connection cable, serial line connection, encoder 
conditions.

StsEncoder.DataRxFlt Errors  in  the  data  received  by  the
serial encoder.

Use proper connection cable, arrange cable away from 
sources of disturbance, check encoder conditions, check the
connection between module and encoder.
If necessary, the parameter “ErrCntLimit” can be increased 
to tolerate more communication errors before reporting.

StsEncoder.MotorOverTemp The motor is overheated Reduce the load on the motor.

StsEncoder.EncInternalFlt There are errors inside the encoder. Replace encoder.

Stsmodule.OverSpeed Exceeded the speed threshold, during 
the “phase” mode.

If the phasing is over, disable the command. If the motor 
has escaped during phasing, the direction of the encoder 
shall be reversed.

StsDriver.AdcLim Saturation of the A/D converter inside
the module.

Verify that the above signals are within the prescribed 
range: AI1, AI2, AI3.

StsDriver.I2cFlt Internal communication problem. Restart the module and see if it appears again.
Notify ALTER Technical Service.

StsDriver.OutFlt Overload on one or more digital out-
puts.

Disconnect the wires connected to the digital outputs and 
after resetting the alarm reconnect them one to one to 
verify what is causing the fault.
In the case of capacitive loads driven by digital outputs, it 
may be necessary to connect a resistance of 100 Ω ½Watt 
in series to the wire.

StsDriver.SupFlt Auxiliary power out of tolerance. Check the supply voltage of the services that is within the 
permissible range.
Select the menu “Auxiliary Power supply voltages”, check 
which one is wrong and notify the ALTER technical ser-
vice.

StsDriver.WdogFlt Cycle time out of tolerance. Notify ALTER Technical Service.
Table 2: Module alarm

Modifiable parameters:

• Parameters.ErrCntLimit: [1 ÷ 255]. This parameter indicates the number of communication error cycles (DataRxFlt) that
are tolerated before generating an error and blocking the module (Fault). In case of disturbances, poor quality cable or other
problems that cause the “StsModule.ComFlt” alarm to appear, you can try to increase this value.

• Parameters.AutoClrFlt: [0 ÷ 255]. With this parameter you can activate the automatic reset in case of alarm caused by the
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encoder, setting it to a value other than 0. This value entered will be the delay in cents of a second that will occur from the
disappearance of the alarm cause to the reset of the module.

5.14.1 Reset alarms
After deleting the cause that produced the alarm it is possible to cancel the signal and restore the normal functioning of the module. To
do this you can do this in 3 different ways:

1. Remove service power for a few seconds and then restore it.

2. Control the digital input 1 (DI1) with a pulse from 0V to +24V for at least one second: this is used to reset from a PLC or
CNC.

3. In the “Project Tree” select the group “Allow module” and press in the line where it says “CmdModule.ClrFlt”; select the
words RESET.

If the FLT LED continues to flash even after completing one of the points listed above, then it means that the cause of the alarm has
not been resolved: See the “Alarms Form” menu (see paragraph 5.14 on page 21).

NOTE: you can activate the automatic reset of the alarms generated by the encoder, using the parameter “AutoClrFlt”, see previ-
ous paragraph.

5.15 Diagnostics
In the “Project Tree” select the group “Diagnostics”: here you can find some data that can be useful for talking to the ALTER tech-
nical service.
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Chapter 6 -  Annexes
6.1 Led Summary Table

The following table lists the components as they appear on the front of the module, starting from the upper left edge.

NAME DESCRIPTION Reference

USB USB USB communication between module and PC Paragr. 5.3 on page 13

FLT Fault Alarm module Paragr. 5.14 on page 21

DI1 Digital Input 1 Command Digital input 1 (Reset Alarms) Paragr. 4.3.8 on page 10

DI2 Digital Input 2 Command Digital input 2 (command increases offset) Paragr. 4.3.8 on page 10

DI3 Digital Input 3 Command Digital input 3 (command decreases offset) Paragr. 4.3.8 on page 10

DI4 Digital Input 4 Command Digital input 4 (not used) Paragr. 4.3.8 on page 10

DI5 Digital Input 5 Command Digital input 5 (not used) Paragr. 4.3.8 on page 10

DI6 Digital Input 6 Command Digital input 6 (not used) Paragr. 4.3.8 on page 10

DI7 Digital Input 7 Command Digital input 7 (not used) Paragr. 4.3.8 on page 10

DI8 Digital Input 8 Command Digital input 8 (not used) Paragr. 4.3.8 on page 10

DI9 Digital Input 9 Command Digital input 9 (not used) Paragr. 4.3.8 on page 10

DO1 Digital Output 1 Status Digital output 1 (signal OK MODULE) Paragr. 4.3.9 on page 11

DO2 Digital Output 2 Status Digital output 2 (signal Communication with ENCODER) Paragr. 4.3.9 on page 11

DO3 Digital Output 3 Status Digital output 3 (signal position ENCODER initialised) Paragr. 4.3.9 on page 11

DO4 Digital Output 4 Status Digital output 4 (signal TIMEOUT ERROR) Paragr. 4.3.9 on page 11

DO5 Digital Output 5 Status Digital output 5 (signal received DATA ERROR) Paragr. 4.3.9 on page 11

DO6 Digital Output 6 Status Digital output 6 (signal INTERNAL ENCODER ALARM) Paragr. 4.3.9 on page 11

ON Module ON Module powered and running (flashing). Paragr. 5.1 on page 13
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Drawing 16: Dimensions
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